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Disclaimer
This document has been carefully prepared and checked. No responsibility can be
assumed for inaccuracies. Elan reserves the right to make changes without prior notice
to any products herein to improve functionality, reliability or other design aspects.
Elan does not assume any liability for loses arising out of the use of any product
described herein; neither does its use convey any license under its patent rights or the
rights of others. Elan does not guarantee the compatibility or fitness for purpose of any
product listed herein. Elan products are not authorized for use as components in life
support services or systems. Elan should be informed of any such intended use to
determine suitability of the products.
Software supplied with Elan PC-Cards, Compact Flash cards or USB devices is
provided “as-is” with no warranty, express or implied, as to its quality or fitness for a
particular purpose. Elan assumes no liability for any direct or indirect losses arising
from use of the supplied code.

Copyright © 2009 Elan Digital Systems Ltd.
Federal Communications Commission (FCC) Statement
This equipment has been tested and found to comply with the limits for a Class A digital device,
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection
against harmful interference in a residential installation. This equipment generates, uses, and can radiate
radio frequency energy and, if not installed and used in accordance with the instructions, may cause
harmful interference to radio communications. However, there is no guarantee that interference will not
occur in a particular installation. If this equipment does cause harmful interference to radio or television
reception, which can be determined by turning the equipment off and on, the user is encouraged to try
to correct the interference by one or more of the following measures:
- Reorient or relocate the receiving antenna
- Increase the separation between the equipment and receiver
- Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.
- Consult an Elan authorized dealer or service representative for help.
Elan is not responsible for any radio or television interference caused by using other than recommended
cables and connectors or by unauthorized changes or modifications to this equipment. Unauthorized
changes or modifications could void the user's authority to operate the equipment.
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two
conditions (1) this device may not cause harmful interference, and (2) this device must accept any
interference received, including interference that may cause undesired operation.
Listed Products
The models covered by this installation guide are intended only for installation in computers for use in
business or home.

Elan Digital Systems Ltd.
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1 OVERVIEW

The USBscope50 is an isolated digital storage oscilloscope that has
the following features:
• Single channel scope with BNC input and USB PC interface
• Each USBscope50 can be stacked to increase channel count (each
requires its own USB connection)1
• 300V Cat II isolation between BNC ground and USB ground2
This means that there is no DC path through the USBscope50
from your scope ground clip to the PC’s ground
• 50MSample/sec single shot sample rate
• 1GSample/sec equivalent sample rate3
• Timebase from 4ns/div to 4s/div in 1,2,4 steps
• 75MHz 3dB analogue bandwidth4
• 3000 sample points, 8-bits per sample
• Pre and post triggering
• AC and DC coupling
• Input sensitivities with x1 probe are 30mV/div, 300mV/div,
3V/div and with x10 probe are 300mV/div, 3V/div, 30V/div;
Input ranges provided by the software from 2mV/Div to 10V/Div
in 1,2,5 steps
• 1Meg input impedance, 16pF
• Channel offset control
• Hardware triggering with >, <, +, – modes
• Refresh or Roll modes for display, depending on timebase
• Host powered from USB (200mA typ)
• Stacked configurations of 2,3 and 4 channels are supported
• Stacked configurations allow any channel to be trigger channel
• Stacked configurations have tight phase locking between
channels
• Probe compensation output, 3V 1KHz
• Power/activity LED

1

A stacking connector pair is required
In stacked configurations the channels share a common ground at the BNC terminals
3
Suitable to measure repetitive signals that are not phase locked with the internal acquisition clock
4
Hardware trigger bandwidth is approximately 60MHz
2

Elan Digital Systems Ltd.
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2 ABOUT THE USBscope50
2.1 General

The USBscope50 uses a 50MSample/sec 8-bit A-to-D converter.
The A-to-D and front-end circuits that process the input waveform,
and the digital stages that acquire and store the waveform are all
powered from the USB host interface via an isolated supply. This
means that there is no galvanic connection between the BNC ground
(or BNC centre terminal), and the USB interface. When you
measure a circuit and connect the scope ground clip to a voltage that
is not at the same ground potential as the host computer, no current
can flow and the host computer is therefore not forced to be at the
same potential as the circuit under test. This clearly has major safety
advantages. The USBscope50 has been designed so that up to 300V
CAT II5, or 500V CAT I can exist between the scope ground clip
and the host computer ground.
Each USBscope50 can be used as an independent single channel
scope but to enhance flexibility several USBscope50s can be stacked
together to make a combined 2,3 or 4-channel device. In this case,
each scope is synchronised with the others so that the compound
device acts like a single multi-channel instrument.
Each
USBscope50 still needs its own USB connection and the combined
device shares a common ground between all the BNC connectors i.e.
the channels are isolated from the USB but not from each other.

5

The CAT rating refers to how large a transient over-voltage may be when connected to the circuit in
question. The USBscope50 is designed to handle a certain transient over-voltage between the BNC and
the USB host i.e. across the internal isolation circuits. The CAT II UL rating defines a more severe
environment than CAT I and hence larger transients are possible. This is why the isolation rating for
CAT II is lower than the rating for CAT I. For further information on CAT ratings please refer to
www.fluke.com
Elan Digital Systems Ltd.
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2.2 USBscope50 Architecture

The figure below shows a simplified diagram of the USBscope50.
STACK
CONN

AC/DC

CONTROLLER
BNC
COMP

USB
CONTROLLER

Trigger

DATA
ATTENUATOR
1Meg

AMP

8-BIT ADC

PSU

ISOLATION BARRIER

Figure 2.2-1 USBscope50 Architecture Diagram

Elan Digital Systems Ltd.
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USB

2.3 Using More Than One USBscope50
2.3.1 Stacked Mode

A unique feature of the USBscope50 architecture is that up to 4
devices6 can be stacked to make a multi-channel instrument.
In order to use a stacked configuration, you will need to use the
connectors supplied with the USBscope50 unit.
You should have a pair of connectors supplied with each unit, one
long one and one short one, similar to these:

2.3.1.1 Assembling The Stack

To stack the USBscope50 devices, first be sure that none of them are
connected to a USB port.
Before you begin, put the short lead connectors to one side…you’ll
only need one of these.
Now, insert one of the long connectors from the top of one of the
scopes (it doesn’t really matter which one). Push the pins of the
connector into the top of the stacking connector from the side where
you can see the top of the black connector down inside the scope.
Be careful when doing this, don’t use too much force or you may
damage the connector pins. Push the long connector all the way in
until it seats down on the scope’s internal connector. You should be
6

Don’t stack more than 4, the software will reject this.
Elan Digital Systems Ltd.
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able to see the gold pins about 2-3mm beyond the bottom surface of
the scope. The connectors have no pin orientation…they can go in 2
possible ways round…both are OK.

Repeat this for all except the last scope to be stacked.
For the last scope in the stack, do the same as above but use the short
length connector. This time, the pins are shorter so they stop well
inside the scope’s case. This scope MUST be the bottom scope in
the stack. The reason for this is that if you use the long connector,
the pins could be shorted out accidentally, or you may touch the pins
when the scope is connected to a high voltage and you could get an
electric shock! Similarly, if you plan to use only one scope, make
sure there is no stack connector fitted or the shorter connector type is
fitted.
This is a safety critical point so please note it carefully.
Now you can assemble the stack.

Elan Digital Systems Ltd.
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Start with the bottom scope. Hold it in one hand, and put the next
scope on top of the 1st, the same way around. Align the stacking
connectors and when the stacking connectors are partly mated
engage the front “P” shaped clip (BNC end) on the 2nd scope into the
“P” shaped slot on the 1st scope.

Now, bring the back edge “P” clip (USB end) of the 2 nd scope down
until it clicks into the 1st scope’s slot. These two scopes are now
mated.

Check that as you pushed the 2nd scope down, the stack connector
has not been forced upward…if it has simply press it down until it
seats correctly (see picture above for a guide as to the normal
exposed connector depth after stacking). Repeat this for each
remaining scope, adding each one on top of the previous one.
The scopes are now stacked.
2.3.1.2 Disassembling The Stack

Start with the top scope in the stack. Grasp the stack in one hand
and with the other hand’s thumb and forefinger, pinch between the
interface between the top two scopes, near the back “P” clip (USB

Elan Digital Systems Ltd.
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end). With moderate force, the top scope will pop up and come free.
Remove the stacking connector from the free scope.
Repeat this for all scopes in the stack.
2.3.1.3 USB Connections For Stacked Configurations

All stacked scopes need a USB connection. A standard hub may
be useful for multi-channel stacks to get enough USB ports.
Each scope needs about 200mA. Plugging more than 2 scopes into a
hub will mean that the hub may need to be powered externally.
Please refer to the hub’s documentation for more details about the
power available per port.
2.3.1.4 Software For Stacked Configurations

When you run USBscope50, it will automatically detect the scopes
connected via USB and will also check to see if the scopes are
electrically connected together via the stack. It will then initialise all
connected scopes, one at a time. This may take a few seconds.
If you stack several scopes but forget to connect say one of the
scopes to a USB port, the software will warn you and will not run.
The software will display a channel “tab” for each scope in use.
The channel number allocated to each scope depends on its serial
number, so the order you stacked them will almost certainly NOT be
the same as the channel order allocated by software.
To find out which scope is Channel 1, use the CH1 tab and click the
“id” button.

Elan Digital Systems Ltd.
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The LED on the scope will blink rapidly and message dialog with
the device information will appear on the screen. Pressing ESC key
will close this window.
Repeat this for each channel in the stack to identify them.
If you like, you can stop the software, and unplug all the scopes
from their USB connections, and then re-stack them in their channel
order.
2.3.1.5 Stacking Do’s And Don’ts

• Do power off all scopes (remove USB lead) before connecting
and disconnecting scopes from the stack
• Don’t remove any scopes from the stack while the software is
running
• Don’t remove any scopes from the stack while any of them are
powered
• Don’t stack several scopes and leave one or more scopes unstacked…this configuration will ignore the un-stacked scopes
• Don’t short circuit any of the stack connector pins, or bend the
pins or use excessive force trying to mate the connectors
• Don’t probe or drive any of the stack connector signals
• Avoid touching the stack connector pins/signals during
stacking

Elan Digital Systems Ltd.
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• Do make sure that each stack connector is properly seated in
place before trying to stack another channel on top
• Don’t allow water or dirt etc to enter the scope via the stack
connector access hole
• Do remember that scopes in the stack are NOT isolated from
each other, they are only isolated from the USB ports. To
re-iterate, stacked scopes have their BNC connector bodies
connected together through the stack connector.
2.3.2 Non-Stacked (MIS) Mode

It is also possible to use multiple USBscope50s as independent
instruments. In this mode, the scopes are NOT connected together
via the stacking interface7.
This configuration is also termed Multi-Independent-Scope mode or
MIS mode.
In MIS mode, each scope can use its own timebase setting, and each
scope input will remain electrically isolated from the others (unless
you connect their BNC grounds together).
2.3.2.1 USB Connections For Non-Stacked Configurations

All scopes need a USB connection. A standard hub may be useful
for multi scope use to get enough USB ports.
Each scope needs about 200mA. Plugging more than 2 scopes into a
hub will mean that the hub may need to be powered externally.
Please refer to the hub’s documentation for more details about the
power available per port.

7

They can of course still be snapped together, but remember NOT to fit any of the stacking connectors
so that the scopes remain electrically independent of each other.
Elan Digital Systems Ltd.
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2.3.2.2 Software For Non-Stacked Configurations

By default when you run USBscope50, it will automatically detect
all the scopes connected via USB and will also check to see if the
scopes are electrically connected together via the stack.
To run in Non-Stacked MIS mode, power USBscope50s via USB
port and run the software. Make sure that software is not running in
demo mode and that number of detected devices corresponds to
number of powered devices. Then plug in the remaining
USBscope50 devices and run the second instance of the Java
application. Software will ignore the scopes that have already been
initialized and are already used and will only attempt to
communicate with the uninitialized USBscope50s.
For example, if you want to run 2 scopes in MIS mode plug in one
USBscope50, and then run USBscope50 Software. Confirm that
channel 1 is detected and running. Insert the second USBscope50 in
the USB port and run another instance of the Java software by
double clicking on the Desktop icon. As software remembers the
position and the window size of last USBscope50 Software
application, two instances of the Java software will overlap. Click
and drag one window and the second application is revealed
underneath. Note the two USBscope50 Software taskbar buttons in
the windows taskbar.

You can simply run multiple copies of the USBscope50 software,
just remember not to power USBscope50 devices all at once.
When running in MIS mode, to easily identify which instance of
software is for which scope you could change the software

Elan Digital Systems Ltd.
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appearance in Settings → Channel Colours and in Settings → Chart
Settings.
2.4 Input Ranges

The USBscope50 supports 3 settings on its input attenuator. These
are then adjusted in the software to expand the range which user can
adjust by pressing the arrow keys.

The ranges at the BNC input depend on the type of scope probe
used:
A “x1” probe causes no signal attenuation and will result in nominal
full-scale input ranges. The bandwidth of x1 scope probes is
generally quite low (10’s of MHz) and the circuit being measured
will see a 1MegOhm load.
A “x10” probe causes a factor of ten signal attenuation. The
bandwidth of x10 scope probes is generally high (100’s of MHz)
and the circuit being measured will see a 10MegOhm load.
The USBscope50 also supports AC and DC coupling:
In AC coupling mode, the input signal is passed through a capacitor
prior to attenuation. The input bandwidth is around 3.4Hz up to
75MHz.
Elan Digital Systems Ltd.
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In DC coupling mode, the capacitor is bypassed and the bandwidth
is DC up to 75MHz.
2.4.1 Offset Nulling

The input stages of the USBscope50 will naturally tend to cause a
small DC offset error in any readings, and this will change from
range to range and from scope to scope. In order to null this offset
out, the software is able to subtract a DC level from all its readings
and its plots, that will help to remove this error.
Select Settings → Offset Nulling and follow the instructions shown
to null each voltage range and each channel. You will be asked to
ground the probe tip. Note that grounding the probe tip as instructed
is NOT the same as selecting GND coupling
USBscope50
adjustments values are then
stored
in
OffsetNulling.config file in the same location where the software is
installed.
Note that there is no difference from a hardware perspective whether
you do this with the channel tab set to x1 or x10 coupling; they use
the same ranges in the hardware. There may be a very small change
in offset in the most sensitive scope input range as you change your
probe itself between x1 and x10 mode, but the software assumes this
change is negligible and only stores one null value regardless of the
coupling selected.
2.5 Probe Compensation

Before taking measurements with the USBscope50, the attached x10
scope probe must be compensated to ensure that it is matched to the
scope input stage8.
This ensures that the probe+scope act together to keep the input
frequency response as flat as possible. Using a scope probe that has
not been adjusted to match the USBscope50 can lead to inaccurate
readings for higher frequency signals.
8

This does not apply to x1 scope probes

Elan Digital Systems Ltd.
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The USBscope50 includes a probe compensation output9.

This must be turned on using the USBscope50 Software. In the
channel tab you will find a button with COMP label. Click on
COMP to turn ON / OFF probe compensation signal. When COMP
button is coloured, you should see a probe compensation output.
Once enabled, the compensation output is a 0 to 3V (approx) square
wave with 50% duty cycle and 1KHz frequency.
The USBscope50 can work with scope probes that list an adjustment
range that includes 16pF. It is best to use probes that have a range
that puts the 16pF point near the middle of the range, for example
the HP10071A type probe lists an adjustment range of 9-17pF and
our tests show that whilst it is easy to compensate this probe against
the USBscope50, the trimmer in the probe body is certainly quite
close to the top end of its range. There are many probe choices on
the market, and lots of them list ranges that span 16pF.10
To compensate your probe follow these steps:
1. Connect your x10 probe to the USBscope50 software and run
the USBscope50 software
2. Set the input range to 500mV/div, x10 probe, coupling to AC
3. Use the channel tab and click on the “COMP” button to turn
on the compensation output

9

Later models have a dual pad compensation point that includes a GND pad
Some very high frequency low capacitance probes may not be suitable for use with the USBscope50

10

Elan Digital Systems Ltd.
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4. Set the timebase to 100us/div
5. Now connect your probe tip to the compensation output on
the scope. You should see a square wave something like this

or it may look more like this

6. You may find you need to connect the ground clip to either
the BNC ground or use the GND pad near the compensation
output11 to achieve a clean waveform with minimal mains
“hum”
11

Be careful not to short-circuit the GND pad to the COMP output with the ground clip. A momentary
short circuit is not harmful but leaving a sustained short may damage the scope’s output
Elan Digital Systems Ltd.
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7. Now, slowly adjust the trimmer in the probe body until you
achieve the best square wave shape that you can. By this we
mean nice square corners and minimum over and under shoot
near the edges. A small amount of over shoot is preferable to
an adjustment with “curved” square wave corners: this would
mean that the scope will attenuate high frequency signal
components whereas a small amount of overshoot will mean
that the scope will tend to slightly amplify high frequency
signal components.
A typical trace, after compensation will look like this.

Some deviation from this is normal due to variations in probe
performance. It is possible that on lower cost, lower
bandwidth probes that you may see a larger amount of
overshoot near the edges. This overshoot may be very
narrow and seem to come and go…this is normal. Better
quality scope probes have better transient response and so
have smaller overshoot.

Elan Digital Systems Ltd.
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2.6 Acquisition Modes

The USBscope50 can acquire waveforms in two different ways.
Single shot and continuous run mode.

2.6.1 Single Shot

In this mode, the ADC is clocked at up to 50MegaSamples/sec.
Each sample is placed into the buffer and then the buffer is painted
on the screen.
This mode is the one to use for non-repetitive signals i.e. single
pulses, irregular bus events etc. It can also be used for repetitive
waveforms.
For practical purposes the maximum frequency sine wave you can
resolve is about 10MHz in this mode, giving just 5 sample points per
cycle: expect to see a very “jagged” and “triangular” looking
waveform when observing a 10MHz input! Drop the input
frequency down to say 1MHz and you will see a nice smooth
waveform.
In single shot mode the timebase can be set from 200ns/div all the
way up to 4s/div. The time to acquire the waveform gets noticeably
slower when rates above 40ms/div are selected: the total acquisition
time is approximately “30 x timebase” so at 4s/div, the display will
update once every 120s, or 2 minutes !
As with all digital storage scopes, be careful not to view a high
frequency waveform on too low a timebase. You may see a
waveform that looks correct but drifts or fluctuates over time, and
that has the wrong frequency…this is called aliasing and is quite
Elan Digital Systems Ltd.
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normal. To avoid this effect, always pick the fastest single shot
timebase consistent with being able to view the waveform in
question.
2.6.2 Random Interleaved Sampling

This mode is a little more complex and is suited only to observing
certain types of waveform.
The USBscope50 includes special circuitry that allows it to trigger
off the input waveform and also to be able to measure the time
between the trigger instant and the first ADC sample that is taken.
In this way, several single shot acquisitions are taken and the data
points for each “sweep” are ordered based on the relative time as
measured. For this to work of course, the relationship between the
trigger instant and the waveform must remain constant i.e. a
repetitive waveform is required like a continuous sine wave or
square wave for example. It also needs the scope to be in trigger
mode, not a free running mode…the software automatically switches
to this mode on entering RIS mode.
The software automatically sweeps the input several times before
updating the display. Because each sweep happens at a random time
with respect to the input waveform, the relative times measured for
each sweep are also random. So it can take a few seconds for the
“picture” of the waveform to update fully. While this acquisition
process is happening, you may see some waveform displays that are
not related to the actual input waveform…this is because the random
nature of the sweeps means that the software may not have
completely built up the picture of the signal, leaving some data from
previous sweeps on the screen. This is normal. Wait a while and the
waveform will update completely.
Another side-effect of the RIS mode is that because the relative
sweep time measurement is “quantized” i.e. the time value is
rounded up or down to place it into one of 20 possible values, or
“bins”, a fast changing input signal can show small anomalies12 on
12

This may show up as small spikes that come and go, particularly near to fast changing edges. In
essence the data for a particular sweep is forced to a particular place on the time axis and these data
points may therefore appear to be in slightly the “wrong” place in time…showing as an error in voltage
Elan Digital Systems Ltd.
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the screen as a result…the software forces the sweep data into one or
other of the bins even though the data may have been at one end of
the “bin” or the other.
RIS mode is not well suited to very slow input signals or signals that
have jitter. This will lead to an uncertainty in the trigger instant and
hence the sweep data will appear in the wrong “bins” and so the
displayed waveform will not “lock” on the screen over time.
Please note that in RIS mode it is not possible to observe the
probe compensation output. This is because it is precisely phaselocked to the ADC’s clock hence there is no way to take random
sweeps to build up the picture...every sweep comes out in the same
bin due to the phase lock. This is normal.
2.7 Trigger Modes

The USBscope50 can use two main types of triggering. These
modes are used when the “Run” button or the “Trigger Single”
button has been pressed causing the scope to enter the run state.

i.e. a spike. This is normal.
Elan Digital Systems Ltd.
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2.7.1 USBscope50 continuous run in Free Mode

In this mode the acquisition begins just after the software has set up
the scope. The scope will effectively free run, with no attempt to
lock to the input waveform and displaying all the the graph as soon
as data is available. Free mode is good for checking DC levels etc.
2.7.2 Normal Triggering

This includes Rising Edge, Falling Edge, More Than and Less Than
trigger options. In this mode, the acquisition is primed, but will not
start until the input waveform meets some criteria. This mode will
cause the waveform on the screen to “lock” to an edge and so appear
fixed in time. It is useful for observing regular waveforms or for
doing a single triggered acquisition. If no suitable waveform is
present, the scope will wait indefinitely with no display update in the
meantime.
2.8 Trigger Position

The total sample buffer is 3000 points long. The acquisition can be
triggered in Norm mode from the input waveform.
By adjusting the trigger position slider, you can make the trigger
position in the buffer earlier or later in time. This is known as pre
and post triggering.13

13

By definition, RIS mode needs repetitive waveforms so pre or post trigger has no relevance.

Elan Digital Systems Ltd.
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2.9 Trigger Threshold

You can adjust the trigger voltage that is used for Norm Modes,
either by moving the slider from the trigger tab. Select View →
Trigger Options and trigger tab should appear on the right hand side
of the USBscope50 Software application.

2.10 Data manipulation
2.10.1 Save Graph

With USBscope50 Java software you can save graph in one of the
following formats: jpg, pnp or pdf. Please select menu option File →
Save Graph.
2.10.2 Export Graph Data

USBscope50 Software displays 3000 data points on the graph. By
Exporting Graph Data you can save all these points in a txt file.
Select Edit → Export Graph Data and Save Channel Data Points
Dialog will appear. You will be given option of saving all the
present channel data starting from channel 1. Save dialog in the title
should say what channel is being exported, Save Channel 1 or Save
Channel 2 and also the file name will automatically begin with Ch1_
or Ch2_ etc. Just click cancel for channels you do not wish to export
data points.
Elan Digital Systems Ltd.
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Remember to stop the acquisitions before saving the data otherwise
the most recent data will be saved.
Data is saved in ASCII text format and will import directly to Open
Office Spreadsheet, Excel, MathCAD.
2.10.2.1 Example Data File

There are 3000 sets of numbers. Document contains the header that
defines the acquisition mode used.
//USBscope50 Software loaded this file with the 3000 graph points.
//Use software option Edit -> Import to recreate the graph.
DATA ON CHANNEL : 2
TIME BASE SETTING : 20 us/div
V/DIV SETTING : 200 mV/div
FILE PATH & NAME : C:\Ch1_.txt
DATE/TIME STAMP : 24-04-2009 09:44:41
0.312
0.324
0.336
0.324
0.336
0.324
0.312
0.336
.
.
.
-0.528
-0.54
-0.54
-0.528
-0.54
-0.552
-0.54
-0.552
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2.11 Import Graph Data

Any text file with the header of exported file and 3000 points can be
imported on the graph. Select Edit → Import Graph Data and these
data points will appear on the channel set in the file header DATA
On CHANNEL. When you select a text file to import, software will
scan through it and will warn you if any of the header settings are
missing, and also will point out the line number where error
encountered.
All lines beginning with “//” in the text file will be ignored by
software. Use this if you wish to write comments or not include
certain data points on the graph.

Elan Digital Systems Ltd.
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2.12 Software Development Kit (SDK) for USBscope50

While running the USBscope50 Java application try selecting Help
option from the software menu or pressing F1 key. You should get
some additional help pages on how to use the software and also
detailed information on SDK for USBscope50. Sources of the
Software, as well as driver sources are made available for you to
download from our website. This information should aid you if you
wish to write your own GUI or device driver.

Elan Digital Systems Ltd.
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3 SOFTWARE INSTALLATION

3.1 Windows XP and Vista14

Before plugging in the hardware:
Use the supplied install CD and run the setup program. This will
copy all the required files and drivers to your PC.
After running the setup program:
Insert the USBscope50 into a free USB socket, or into a USB hub
port. A USB extension cable can be used if needed.
During installation hardware device is detected: “USBscope50”.
After installation the device manager will look like this16:

14

15

.

Include Language variants using the DBCS character mappings e.g. Chinese, Japanese, Korean etc

If Windows prompts to search the Internet for a driver, select “Not
this time”, and when it warns about Unsigned Drivers you MUST
click on “Continue Anyway”
15

16

The COM port number will be platform specific, this is just and example

Elan Digital Systems Ltd.
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Once the hardware has installed, there is no need to make any
settings for the allocated COM port…the software takes care of all
this at run time17.
Start the USBscope50 software and you will see the following
display:

To find out what the various buttons and knobs do, simply hover
over them for a brief explanation.

3.2 Linux Ubuntu

Elan USB Test & Measurement equipment consists of 4 different
USB devices USBscope50, USBwave12, USBcount50 and
USBpulse100. These devices all use SiLabs driver, cp2101.c, which
is included in the kernel. When you plug Elan USB device if driver
is loaded the red led on the device will come on. If LED is off, it is
most likely because these 4 lines are missing from the cp2101.c file:
{
{
{
{

17

USB_DEVICE(0x10C4, 0xF001) }, /* Elan Digital Systems USBscope50
USB_DEVICE(0x10C4, 0xF002) }, /* Elan Digital Systems USBwave12
USB_DEVICE(0x10C4, 0xF003) }, /* Elan Digital Systems USBpulse100
USB_DEVICE(0x10C4, 0xF004) }, /* Elan Digital Systems USBcount50

You may be prompted to alter the COM port number…please follow the on-screen instructions.

Elan Digital Systems Ltd.
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Please copy USBscope50Drvr.so to /usr/lib making sure you have
root privileges. Copy USBscope50_Software.jar and lib folder in the
same location. To run this Java Application you need Java Runtime
Environment (JRE). USBscope50 Software is not bound to a JRE
version, but we would advise customers to keep JRE up to date.
Software was tested on JRE version 6. For more information and
instruction on how to install JRE, please refer to Java Sun website
www.java.com.
Run USBscope50 Software from the terminal
java -jar “path to/USBscope50Software.jar”
3.3 Troubleshooting

• Check that the scope hardware installed properly. Use the
device manager as shown above and check that there are no
yellow exclamation marks on USBscope50 device. If there
are, try deleting that device, then un-plug and re-plug the
scope.
• Make sure that you do not press cancel or stop during any part
of the hardware installation. If you did, use the device
manager to delete any USBscope50 devices shown, the re-plug
the device and try again
• If you are still having problems please use the Windows
“PrtScr” button to make a screen capture of the application.
Then paste this into a Word or Paint document and send it to
tech support.

Elan Digital Systems Ltd.
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4 HARDWARE SPECIFICATION
All parameters typical @ 20°C unless otherwise stated

4.1 Power Requirements
Supply Voltage:
Total Supply Current:

5.0V
±10% from host USB bus
200mA avg

4.2 Mechanical
Mass:
Case Material Data:
Size (typical in mm):

42g typ.
Polycarbonate (UL94V rated)
99.618 x 30.6 x 17.519

4.3 Environmental
Humidity:
General Operating Temperature:
Specific Operating Temperature:
Full Warm Up Time:
Storage Temperature:
Operating Location:
Operational Category:
Pollution Degree:

18
19

<80% non condensing
-10°C to +45°C Ambient
22°C ±3°C for rated accuracy
10mins for rated accuracy
-40°C to +80°C Ambient
Indoor or under-cover use only
Cat II
2

From BNC end to USB end
Not including “P” clips on base

Elan Digital Systems Ltd.

31

USBscope50 USER’S GUIDE Iss8

4.4 Performance
4.4.1 Safety Data and Maximum Ratings

Important Safety Precautions
Always observe these when using the USBscope50
The USBscope50 contains no user serviceable parts inside.
Do not open the plastic housing.
There may be lethal voltages inside the plastic housing. Do
not use the instrument if the housing is damaged or is
poorly fitting. In such a case do not connect anything to the
USBscope50 to avoid a hazard. The USBscope50 will have
to be repaired or replaced in such a situation.
Do not exceed the maximum ratings listed below.
Never use the instrument if it becomes damp for any reason.
This includes situations were condensation has formed on
the unit due to sudden temperature or humidity changes.
Never use test leads that are damaged or have insufficient or
incomplete insulation.
Never allow any conductive part of any test lead to contact
the host computer ground. Doing so will bypass the safety
isolation in the USBscope50 and could cause a lethal
hazard.
Remember that the isolation is between the BNC and the
USB connectors. The BNC is, of course, at the same
potential as the test lead ground clip to which it is
connected. Be careful when measuring hazardous voltages
not to touch the BNC connector ground for this reason20.
Only use the shorter length stack connector in the bottom
scope of the stack, and if using a single scope, don’t fit any
stack connector at all. This is to avoid touching the contacts
20

This is true of almost all scopes, except that most scopes have no isolation to safety earth…in fact
normal scopes connect the BNC ground directly to safety earth. If you were to connect a probe ground
clip to an earth referenced potential you would short it out on a normal scope!
Elan Digital Systems Ltd.
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Isolation rating:

300V CAT II, 500V CAT I between BNC
ground and USB ground
Transient isolation21:
BNC ground to USB ground +/-2.5KV
22
Isolation capacitance :
1000pF typ between BNC ground and USB
ground
Maximum Measured Voltage:
Between BNC center and BNC ground: +/-30V.
Absolute Maximum Input Voltage23: Between BNC center and BNC ground:
148Vrms or 148Vdc.

4.4.2 Static Performance
Input DC resistance:
Input capacitance:
Range accuracy:
Input coupling modes:
ADC vertical resolution:
Channel offset error:
Channel offset control:
Buffer depth:
Pre-triggering:
Post-triggering:
Triggering:
Trigger delay:
Trigger range:

1Meg Ohm ±2%
16pF ±10% at 1MHz
+/-0.3V range:
±4%
+/-3.0V range:
±6%
+/-30.0V range:
±6%
AC, DC, GND
8bit
±2% of range
±100% of range, approx 7bit resolution
3000 points
Up to 99% of buffer depth24
Up to 100% of buffer depth
Normal, rising edge, falling edge, greater, less
From 0 to 65535 sample periods
±100% of range, approx 7bit resolution

21

This figure derives from the 300V CAT II isolation rating and defines the peak transient voltage that
can be safely tolerated between the BNC ground and the USB ground.
22
This capacitance causes the impedance across the isolation barrier will reduce with frequency. This
is only significant if an AC component is impressed between the BNC ground and the USB ground that
is referenced to the USB ground. At 50/60Hz this impedance is approximately 3MegOhms.
23
This level will saturate the scope input, and is the maximum that can be applied without causing
damage to the scope. It applies regardless of the input attenuator or coupling setting.
24
Single shot mode only
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4.4.3 Dynamic Performance
Maximum ADC single shot rate:
Maximum effective sample rate25:
Sample rates available:
Sample rate accuracy:
Stacked scope channel skew:
Analogue 3dB bandwidth:
AC coupling 3dB high pass freq:
Analogue trigger 3dB bandwidth26:
SFDR:

50MSPS
1GSPS
4ns/div to 4s/div in 1,2,4 sequence
0.02% typ
±2ns between any channel pair typ
75MHz typ
3.4Hz typ
60MHz typ
50dB typ

Compensation output:0 to 3V nominal 1KHz square wave, absolute max source/sink
current 1 mA

4.4.4 Miscellaneous
USB transfer rate:
USB device ID:

USB 2.027 Full Speed 12MBits/sec
10C4 F001

4.4.5 Software
USBscope50 support:
Recommended system:

XP/Vista
Pentium Class 600MHz or better, 16-Bit colour
depth graphics or better with graphics
acceleration, 800x600 min screen resolution,
256MBytes RAM

25

Using RIS mode
The circuit involved with triggering causes the maximum input frequency that can trigger the scope to
be lower than the scopes measurement channel bandwidth.
27
Works in USB 1.1 or USB 2.0 hosts using the 12MBits/sec full speed mode
26
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